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Introduction 
Create a new folder on your desktop and label it with your name.  To do this, have your cursor on the 
desktop, (not on an icon) and right click. A drop down menu gives you the choice of “new”, then “folder”.  
Rename it with your name.  Next, drag the JPDYTEM file into your new folder.   Double click on the 
JPDYTEM folder, then double click on the file called JepdyTemp to open it.  Go to file/saveAs, and 
rename the opened JepdyTemp file to something with your name, such as MarieJepdy.  This way you have 
saved the Jeopardy Template file, and have a file with your name on it that you can make changes to.  
 
When to Use the Game 
Gagne's “Events of Instruction” include steps for providing learning guidance, eliciting performance and 
providing feedback.  The Jeopardy game is an excellent way to cover these three “events.”  Make sure 
your questions are ones you presented when the material was covered, and include these questions in a test 
after the class plays the Jeopardy game. 
 
Overview of Playing the Game 
With your _____Jepdy file still open, go to the top menu bar, select View, and pull down to Slide Show.  
Click the red button to go to slide 2 (Directions).  Hit the escape key (Esc) to go back to the normal view.  
Go to slide 3 to see the interactive game board showing the categories and amounts. 
 
Views in PowerPoint 

1. Normal View – You can edit slides in this view (View/Slide) 
2. Slide Sorter View – You can select, copy/paste, or delete slides in this view (View/Slide Sorter) 
3. Slide Show View – This is the presentation view (View/Slide Show) 
 

Planning Chart 
Go to the last page of this handout.  The chart represents slide 3 with the categories and amounts.  Note, 
for example, that the first square, category 1 for $100, is slide #4, a statement.  It links to slide #5, the 
question that must be posed by the student in response to the statement.  With younger students it is better 
to make the statements actual questions, and have the students respond with the correct answer for the 
question.  It’s harder for K-5 to read a statement and then formulate a question in response to the 
statement.  However, it is a good “stretch” of their thinking ability to have higher grades formulate the 
question.  Notice that all of the “statement” slides are even numbers.  All of the “question” slides are odd 
numbers. 
 
When you click the button on slide 5, it returns you to the category/amount slide (#3) so the next team can 
take its turn.  Play continues until all of the categories and amounts have been chosen.  Notice that after a 
category and amount has been chosen, it changes colors so that the teams know which ones have already 

Category 1 Category 2 Category 3  Category 4  Category 5 
$100 $100 $100 $100 $100 
$200 $200 $200 $200 $200 
$300 $300 $300 $300 $300 
$400 $400 $400 $400 $400 
$500 $500 $500 $500 $500 
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been selected.  It’s a good idea to have a “Vanna White” (Wheel of Fortune) at the white board with a 
copy of slide 3 drawn the board.  Then when an amount is chosen, “Vanna” x’s it out and puts the team 
name in the box (if guessed correctly) to keep score. If they give a wrong answer, no team name is placed 
in the square.  It is simply crossed out.  Before entering the statements and questions you will use for your 
Jeopardy Game, we will change the category titles on slide 3.  Move to slide 3. 
 
Changing Category Text 
 Make sure the standard toolbar is showing (View/Toolbars/Standard).  Change the percentage size so that 
you can view the entire game board (i.e. 75%).  Click on the text in Category 1, “Revolutionary War”.  A 
small box should appear around the text.  When your cursor changes to an “I” beam, click and highlight 
the text, then press delete.  Type in your new category name.  You will do the same for the other four 
categories.  If you want only 20 questions instead of 25, you can click and drag over the last column and 
delete it and move the other columns over with the arrow keys.  To move something in small increments, 
select it, hold down the control key, and nudge with an arrow key.  We will have time later to change the 
rest of the category titles. 

 
Changing Text and Box Colors 
Click Format on the top menu bar.  Pull down to Apply Design Template.  Select a template that matches 
your Jeopardy Game theme.  Click Apply.  Notice that the game board (slide 3) changes, as well as the 
statements, questions, and title slide.  Check to make sure that the followed hyperlinks change.  Go 
View/Slide Show and select an amount, and answer the question.  When you come back to slide 3, did the 
amount change colors to an appropriate?  If not, go to the Format menu.  Pull down to Slide Color 
Scheme.  Select Custom.  Choose a color that fits your scheme for Background, Accent and Followed 
Link, and Accent and Followed Hyperlink. Click Apply to All and check the links again to make sure they 
change on slide 3.  We will take 8-10 minutes to explore various templates 
 
If the text or backgrounds on slide 1 or 2 don’t match your theme, change them in the drawing toolbar 
using either the font color or fill bucket.  If the red buttons on the statements and do not match your theme, 
you will have to change each by hand.  An easy way to change the button color is to click on the first 
button on page 1 (make sure it has “handles”), then click the Fill Bucket in the Draw tool bar.  Pick a color 
that matches your theme.  With the newly colored button highlighted, copy the button  (Edit/Paste or 
Control/C), then go to the next statement, delete the old button, and go to Edit/Paste (or Control/V) to 
paste in the new button.  Do the same for the rest of the buttons. 
 
Daily Doubles 
In the Slide Show view, go to slide 3 and click on column 3 for $100.  Notice that it goes to a Daily 
Double instead of to slide 24.  That’s because the box for column 3 for $100 is programmed to link to 
slide #54, the first Daily Double. Hit Escape, then go to View/Slide Sorter.  Notice that the last two slides 
are Daily Doubles.  
 
For practice, we will now program the box in column 3 for $100 so that, instead of going to the Daily 
Double, it will link to slide 24.  It’s good to know how to change the Daily Double links because, after 
playing this game with your students one time, if you use the same template to create a new game, your 
students will remember where the Daily Doubles were last time!  (Also, it’s fun to see their surprise when 
they realize you’ve moved them!!) 
 
Switch the PowerPoint to View/Normal.  Go to slide 3, column 3, and click the I beam once on the $100 
in the box.  Click on Slide Show on the top menu bar and pull down to Action Settings.  Again, notice that 
this box is currently linked to slide #54, the Daily Double. Click the triangles on the right, then click Slide.  
Then link it to slide 24, (the slide it would go to after the Daily Double slide, #54).  Click ok twice to close 
the dialog box. 
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While still in the Normal view, go to slide #54.   Place the cursor just under the words “Daily Double.”  
When the cursor is a 4-headed arrow (not an I beam), click once on the inside box.  Then go to Slide Show 
on the top menu bar and pull down to Action Settings.  Click the triangle to the right.  Then go to the word 
Slide in the box.  Notice that the highlighted text is slide #24.  That’s why this DAILY DOUBLE (slide 
#54) previously linked to slide #24.  Now change the link to a slide # of your choosing (suggestion: pick 
one in either the $100 or $200 category).  Write this number down! You may also want to change the 
sound from the gong to the clickish.wav.  Click ok, then click the 2nd ok.  Also click the outside square and 
program this object as well to your new slide # and sound. 
 
Next, go to the category and amount row and column on slide 3 that matches the number you linked with 
the Daily Double on slide #54. Click the I beam once on the dollar amount in the box.  Click on Slide 
Show on the top menu bar and pull down to Action Settings. Click the triangle to the right, then go to the 
word Slide in the box.  Link this to slide #54. 
 
Now, change the second Daily Double link on Slide #55 to a new slide #, using the same steps as above.   
 
Suggestion:  always keep at least two Daily Doubles in the game.  Students will think it is “unfair” if 
there is only one Daily Double, because both teams won’t have a chance to get one.  Also, link the Daily 
Doubles to either a $100 or a $200 box because students usually choose the lesser amounts near the end of 
the game.  This makes it possible for a team to pull ahead near the end.   

 
Customizing Statements and Questions:  Use the attached Planning Chart to plot your statements and 
questions.  Then go to slide 4 to begin entering your new statements and questions.  You can also change 
slides in the Normal View mode by clicking on the slides on the left side of the screen.  Use the icon in the 
lower left corner to get to this view, or choose Normal View from the View menu at the top. 
 
 
MORE ADVANCED POWERPOINT USERS 
 
Add a Picture and a Sound 
Go to slide 4.  Go to the Insert menu at the top.  Pull down to Picture, then go to From File.  Go to the 
JPDYTEM folder.  Find the Stamp_1.jpg picture and click insert.  It pops the image onto slide #4.  Resize 
and place the picture where you think it looks best on the slide.   
 
While still on slide 4 select Insert again.  This time, pull down to Movies and Sounds.  Choose Sound 
from File.  Click on THUD.WAV in the JPDYTEM folder.  You will be prompted with the question, “Do 
you want to the sound to play automatically?”  Choose “no.”  Now go to Slide Show, slide 4, and click on 
the speaker to see what happens. 
 
Go to slide 1.  Select “Insert.”  Pull down to “Movies and Sounds.”  Choose “Sound from File”. Click on 
yankeeWhistle.wav, which is in the JPDYTEM folder.  The icon of a speaker will appear on slide #1.  
You will be prompted with the question, “Do you want to the sound to play automatically?”  Choose “no.”   
Go to Slide Show view, and notice that the old Yankee Doodle plays automatically.  Yours doesn’t.  Now 
click on the speaker icon for your Yankee Doodle to hear it play.  To insert a sound that is appropriate for 
your Jeopardy Game, you could go to http://www.altavista.com  and click the MP3/Audio tab and then 
type in the name of a song you would like to insert.  Be careful not to insert copyrighted songs, such as the 
Jeopardy Theme.  Legal limits are usually 30 seconds or 10% of a song, whichever is less. However, 
popular copyrighted themes may not be reproduced at all (for example, just the few notes of “I can’t get 
no satisfaction” would be illegal, because it is so recognizable).  When inserting music, it is best to choose 
a song with a .wav extension rather than an MP3 or other formats because they are more compatible with 
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both PC’s and Macs in the PowerPoint application.  One of my favorite sound CD’s is “A Zillion 
Sounds” produced by BeachWare, http://www.beachware.com for $24.95 (sometimes on sale for $19.95). 
They now have posted these online for free as mp3 sounds, which you could convert to .wav files in a 
program such as Audacity (free at http://audacity.sourceforge.net/), if you had trouble with the mp3 files. 
 
 
There is a lot of free clip art on the web.  One suggestion is to type the name of what you’re looking for in 
the Google search box, then click images on the top left.  This gives you thumbnails of hundreds of 
pictures in your subject area from which you can choose. Once you find a picture you like, first make sure 
it is not copyrighted!  If it is, you must email or write to the copyright owner to get permission to use it.  
When you find a usable picture, right click on a PC, or hold the mouse until you get a pull down menu on 
MAC, and download the picture to the folder in which you will keep your Jeopardy Game.  Then, in your 
PowerPoint, go to the slide where you want to enter the picture. As a short-cut, simply have the Internet 
and your PowerPoint open, side by side, and drag the picture onto your PowerPoint slide 
  
Design Principles 
 
The Non-Designer’s Web Book by Robin Williams (not the actor) and John Tollett (PeachPit Press 
htp://www.peachpit.com/) provides great design principle tips.  You can also find more tips at: 
http://www.ratz.com/featuresbad.html. Here is a summary of four basic design principles. 
 
Contrast: Use a dark text on light background, or a light colored text on a dark background.  Also, make 
sure the page layout uses some color contrast within the page. 
 
Repetition: If you have buttons or icons repeated within a slide show or web page, repeat the same style 
and color designs.  Locate buttons or icons in the same place on each slide.  Use a similar color scheme or 
font style throughout the presentation.  For example, use a serif font (one with tails) for titles and a sans 
serif font (without tails) for the text.  This provides contrast as well as repetition within the presentation. 
 
Alignment: Avoid the overuse of center alignment in presentations.  Try to line up buttons or graphics 
with a left or right alignment of text.  Avoid scattering text and/or graphics randomly on a page.  Keep in 
mind an attractive horizontal alignment arrangement, as well as good vertical alignment. 
 
Proximity: Information that goes together should be presented together.  For example, on a business card, 
don’t put your name, then your phone, then your title, followed by an address and email.  Group all of the 
title information together, and group all of your contact information together.   
 
I tell my students that failure to follow these four simple design principles will result in a presentation that 
looks like the first letters of each of the above four words.  When they figure out what it spells, they never 
forget the four principles again!  
 
Link to downloads for these directions, and for the template: 
http://web.mac.com/mariesontag1/Clips/Jeopardy_Game_Downloads.html 
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PowerPoint Jeopardy Game Planning Chart 

Category #1 Category #2 Category #3 Category #4 Category #5 

$100  - Slide 4 
Statement 
 
 
 
Slide 5 Question 
 
 
 
 

$100 - Slide 14 
Statement 
 
 
 
 
Slide 15 Question 
 
 

$100 – Slide 24 
Statement 
 
 
 
 
Slide 25 Question 
 
 

$100 – Slide 34 
Statement 
 
 
 
 
Slide 35 Question 
 
 

$100 – Slide 44 
Statement 
 
 
 
 
Slide 45 Question 
 
 

$200 –Slide 6 
Statement 
 
 
 
 
Slide 7 Question 
 
 
 
 

$200- Slide 16 
Statement 
 
 
 
 
Slide 17 Question 
 
 

$200 – Slide 26 
Statement 
 
 
 
 
Slide 27 Question 
 
 

$200 – Slide 36 
Statement 
 
 
 
 
Slide 37 Question 

$200 – Slide 46 
Statement 
 
 
 
 
Slide 47 Question 

$300- Slide 8 
Statement 
 
 
 
 
Slide 9 Question 
 
 
 
 

$300 – Slide 18 
Statement 
 
 
 
 
Slide 19 Question 
 
 

$300 – Slide 28 
Statement 
 
 
 
 
Slide 29 Question 
 
 

$300 – Slide 38 
Statement 
 
 
 
 
Slide 39 Question 

$300 – Slide 48 
Statement 
 
 
 
 
Slide 49 Question 

$400 – Slide 10 
Statement 
 
 
 
 
Slide 11 Question 
 
 
 
 

$400 – Slide 20 
Statement 
 
 
 
 
 
Slide 21 Question 
 

$400 – Slide 30 
Statement 
 
 
 
 
 
Slide 31 Question 
 

$400 – Slide 40 
Statement 
 
 
 
 
 
Slide 41 Question 

$400 – Slide 50 
Statement 
 
 
 
 
 
Slide 51 Question 

$500 – Slide 12 
Statement 
 
 
 
Slide 13 Question 
 
 

$500 – Slide 22 
Statement 
 
 
 
Slide 23 Question 
 
 

$500 – Slide 32 
Statement 
 
 
 
Slide 33 Question 
 
 
 

$500 – Slide 42 
Statement 
 
 
 
Slide 43 Question 
 
 
 

$500 – Slide 52 
Statement 
 
 
 
Slide 53 Question 
 
 
 

 Slide 54  - Daily 
Double 

Slide 55  - 
Daily Double 

 
 

 


